Service No. . UG-OSCAR-laaS
Orchestration _
User Guide oue 2 4
PCCW Global G | Orderi
(General Ordering | ... C Lof26
Flow & laaS
Product) Issue Date : 01 Mar 2017

Service Portal
Service Orchestration User Guide
(General Ordering Flow & laaS Product)

Disclaimer:

This publication has been prepared and written by PCCW Global and is copyright. Other than for the purpose of and subject to the conditions
prescribed under the Copyright Act, no part of it may in any form or by any means (electronic, mechanical, micro copying, photocopying recording
or otherwise) be reproduced, stored in a retrieval system or transmitted without prior permission. Product or company names are trademarks or
registered trademarks of their respective holders.




Service No. UG-OSCAR-laaS
U G . d Issue 4
(General Ordering | 5, 5 of 26
P rod UCt) Issue Date 01 Mar 2017
Amendments
| Indicates Sections that have been changed since last revision
Date Issue Details of Amendments By
28" April 2016 0 Draft version Gabriel NG
22™ July 2016 1 Add Infrastructure as a Service (laaS) Change VM service Gabriel NG
30 Aug 2016 2 Add, Change and Delete Cloud Connect (Private cloud) to MS Azure Raymond Leung
31 Aug 2016 3 Support Change of COS and IP White List for laaS Connect Raymond Leung
27 Sep 2016 4 Change this document to describe the standard Ordering processes for Raymond Leung
Adding/Changing/Terminating a Service by taking laaS Product as
illustration, whereas other Products will be described in separate
documents
24 Nov 2016 5 Add VM Start/Stop/Reboot; Update Print Screens Patrick Chan
1 Mar 2017 6 Update Print Screens Patrick Chan

File name: Service Portal Service Orchestration User Guide (General Ordering Flow & laa$S Product) V4.docx




Service No. . UG-OSCAR-laaS
Orchestration
User Guide
(General Ordering | ... . 30f26
Flow & laaS

Issue : 4

PCCW Global

Product) Issue Date : 01 Mar 2017
Print date & time: 4/26/2017 12:17 PM
Table of Contents

1. DOCUMENT PURPOSE ......ccceeeeeeeeeeieeeeeeeeeeeeeeemeeeeeeeeeesesssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssnnnssnnnnnnnnnnnnnnnne 4
2. INTENDED AUDIENCE ........cceeeiieerersrsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsnnns 4
3. BACKGROUND ......cuuiiiiiiirsrssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssssssnsnnsnnns 4
4. WHAT YOU CAN DO WITH SERVICE PORTAL SERVICE ORCHESTRATION.......ccteuuieitennieriennieniennicnsensiensanssessanssessansssssansssnes 4
5. LOGIN TO PORTAL.....cucererrsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssss 5
DL LOGIN PAGE .eteeeeetteeeeetee e eeteeeee et e e ee e e eeteeeeeeaaeeeeetaeeeeaateeeeesseeeeetsaeeeassaeeeesseeessseeeeasseeeennseeeentseeeeansseeeaseeeeesseeeeanteeeeennes 5
5.2 LOGIN SUCCESSFUL = LANDING PAGE ....veeeceuveeeeiteeeeeiteeeeeeteeeeeiteeeeeitseeesetseeeessseeseeasseesensseeeeasseeseassseeseatseeesasssesensseesensseseeanssesensees 5
6. MY PRODUCTS.......ouucceiiressssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssnsnnsnnnnnns 6
7. ADD NEW SERVICES........cccceeirerrrrssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsnnsnnns 7
7.0 STAGE L: SELECT SERVICE...uuuuuuuuuuuuususususususssssssussssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssnssssnnnnsnnnnnssnnnnns 7
7.2 STAGE 2: CONFIGURE PRODUCT ...tuututtuutuuuutuuususuuuauausssususasasasssssssasasssssssssssssssasssssssssssssssssssssssssssnssssssssssssssssssnssssnsnsnsnsnnsssnsnnnsnnnnns 8

7.2.1 Create New 1aaS CONNECt ANA NEW OGS ........cccueveveeeeeeeeeeeeeeeeeeeeeeettteeee e e eeetiareeeeeeeeesssasasaeaeeeessstsssaesseeesessssesees 9

7.2.2 CreQte NEW IQQS ONY....cc..oeeeeieieee ettt ettt et s st e st e st e st e st e s teesabessteesaseasaseasasees 10
7.3 STAGE 3: GET QUOTE (FOR ADD AND CHANGE SERVICES) .....uvveeeivreeeestreeeeeseeeeesseeeeessseeeeesseessssseesesssesessssssesensseseenssssessssesesssseseenns 11
7.4 STAGE 4: SHOPPING CART AND SUBMITTING ORDERS (TURNING QUOTATIONS INTO ORDERS) ..veeuvveerureesreerreesueesseesssesssseesssesssseessseesns 12
8. ORDER ENQUIRIES — CHECKING ON PLACED ORDERS ......ccceiiiiiiiiiiiiiissssssssessssssssssssssssssssssssssssssssesssssssssssssssssssssssssssanns 16
9. CHANGE SUBSCRIBED SERVICES .....cccciiiiiiiiiiiiieiesesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnnns 17
9.1 CHANGE IAAS VIM FAVOR (CONFIGURE STAGE) «..uvveeeetreeeeeuureeesuseeeesssesessssssesassessasssseesasssssssssssssassssssssssssssssssssesnsssssssssssssssssessanes 17
9.2 CHANGE IAAS CONNECT BANDWIDTH, COS AND IP WHITE LIST (CONFIGURE STAGE) ....uvvvieeeureeeeireeeeensreeeeeseeeeentreeeensneeeeeseseesssneseenes 19
9.3 VM START/STOP/REBOOT ....veeuvieuveeueeereeeteeteeseeseesesssesseesseesseeseensessseessasssassseteenseessesasesasesssesseesssenseenseessesssessaeateenseensesnsesnnas 20

Lo Y Y ([ e Ky e T T=To IRV 1 SR 20

9.3. 250D A TUNINUNG VIM....oeeeieeeeieeeee ettt ettt e e e e s ettt e e e e e s sttt aaaeesssastteaaaasssssassstseaassassnsssteasssssssnsssseneeas 21

9.3.3 REDOOL A FUNNING VIM ...ttt e e ettt e e e e e e et aa e e e e e ettt e aaaaeeeasstsaseaaaeeasstssseaasaeesassssanasas 22
9.4 VM START/STOP/REBOOT GENERAL RULES....cciuteieieittieeieteeeeesatteeeeetteseseaatessssbeeessssessesesasessssbesessseesssasesessanbeeessssessesssbeesssseressnes 22
10. TERMINATE SUBSCRIBED SERVICES.......ccceteutttentreniereserencernseressssnsersssssasessssssssssssssssssssssssassssnsessssssnsesassssnsesassesnssssnsenns 22
10.1 TERMINATE |AAS CONNECT OR |AAS (CONFIGURE STAGE)...eeeuuvveeesutreesasureeessssesesssseesasssseesssssssssassesssssssessasssssessssssessnssesssnssssssssens 23
L1, APPENDIX ...cceveeeeeeeeeeeeeeeeeeeessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssssssnsssnnnnnnnnnnns 26




Service No. - UG-OSCAR-laaS
Orchestration _
User Guide ssue -
PCCW Global G | Orderi
( enera r erlng Page . 40f26
Flow & laaS
Product) Issue Date : 01 Mar 2017

1. Document Purpose

This document provides general information and instructions to guide users of the PCCW Global
Service Portal to subscribe for new services, change subscribed services and terminate subscribed
services via service orchestration functions. For ease of reference, the laaS service will be shown as an
illustration in this document. For configuration and ordering of other Products, please see separate
documents for the details.

2. Intended Audience

This document is accessible to and intended for users of the Online Service Portal that includes PCCW
Global administrator, customer administrator, and customer user.

3. Background

Working through PCCW Global’s Service Portal is our Service Portal Service Orchestration, a web-based
application that serves as a platform for providing customers, resellers, and partner’s self-service
product management and network provisioning.

4. What you can do with Service Portal Service Orchestration:

e Subscribe to new services, for example:

» Add Infrastructure as a Service (laaS)

» Add laaS Connect i.e. connect laaS to an existing MPLS L3 VPN service
e Enquire on saved quotes of intended service subscriptions
e Change subscribed services, for example:

» Change laa$ Virtual Machine Favor (Upgrade only)

» Change laaS Connect Bandwidth, COS and IP White List
e Terminate subscribed services, for example:

» Terminate laaS

» Terminate laaS Connect
e Enquire on subscribed service(s) with PCCW Global Ltd.

Restriction on removing laaS Connect:
- If there still is a laaS service i.e. Virtual Machine exists, the 1aaS Connect is not allowed to be removed.
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5. Login to Portal

5.1 Login Page
Every user must login to the Service Portal in order to use its functions.

PCCW Global

Service Portal

Login

Please log in to access the PCCW Global service portal

HKTHmoTUﬁw\'(' Copyright ® 2016 PCCW Global | About PCCW Global | Terms and Conditions | User Guide a POCW-HKT Group member

5.2 Login Successful - Landing Page

My Products My Services o ¥ & A&

Welcome to the PCCW Global Service Portal

Incident Management . Invoices
Track and report your services incidents r va) Access and track your
invoices

Usage Analytics Cloud Connect laaS
MPLS, VPN service reports Flexible, secure Global cloud computing on-demand
connection to public cloud
vendors

HKT .. s Copyright © 2017 PCCW Global | About PCCW Global | Terms and Conditions | User Guide a PCCW-HKT Group member
To | Help & Support
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6. My Products

Customers can go to “My Products”, click on laaS and the Global View will be displayed. On the
Global View, the global map is displayed with colored markers representing the locations of the
subscribed services.

Services at different stages are reflected in different colours, i.e.:
o Grey — New Addition

e QOrange — Under Provisioning

e Green —In Operation.

Available services are listed in the graphical menu on the right side. To subscribe to a new service,
simply select a product from the menu, hold and drag the product icon, then drop it onto the map
area.

My Products My Services = ¢' ‘ #

: ;

SlQud Connect

Infrastructure-as-a-
Service

(@) 'as
‘éj (Hong Kong)

laas
_/ (Reston

Map data 2016 | Terms of Use

Generally, service subscription on the Service Portal follows a simple operation flow with 4 Stages:
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Select > Configure > Quote > Order

7. Add New Services

7.1 Stage 1: Select Service

Wiy

e Drag the laaS product icon from menu bar and drop it on to the map area
> A marker will fall onto the site area. A grey colour icon will show

A number will appear on the configuration icone to indicate the number of configurations have been
selected

My Products My Services =% & A

e

/= laas
=

‘/ (Hong Kong)

@\ laas

— (Reston)

Map data ©2016 | Terms of Use

e Next, click on the configuration icon 6 to configure the details of the service.
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7.2 Stage 2: Configure Product

\N

e On the configure page, all the actions (Add New, Change, Terminate, etc.) made on the Global View
are shown

My Products My Services i # ‘ #

= (3]

Configure Service

Please configure your service before requesting your quote

1 New Service laaS Reston
2 New Service laaS Hong Kong
3 Change MPLS Hong Kong OCRO005.0001.1V.01

e Select and click on an item. The item line will expand and display options/configurable items

e Different services have their own options/configurable items. The subscription or configuration
process varies by service.

e For laas, there are 2 possible cases for service subscription, namely:

> "Create New laaS Connect and New laaS" if the site does not have laaS Connect

> "Create New laa$S only" if the site already has laaS Connect.
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7.2.1 Create New laaS Connect and New laaS

Configure Service

Please configure your service before requesting your quote

1 New Service laas Reston
2 New Service laaS Hong Kong
Select a Server Package
Package vCPU RAM HDD Monthly Charge
1 2Ge 100GB UsS$43
| c1-standard-2 ‘
f 1 4GB 100GB uss$62
| c1-standard-4 ‘
f 1 8GB 100GB US$96
| c1-standard-& ‘
f ) 16 108GB 100GB uUss$s40
| c16-enterprise-108 ‘
f 2 16GB 100GB ussi71
| c2-highmem-16
2 8GB 100GB uUss$110
| c2-standard-& ‘
i ) 24 120GB 100GB uUs$2400
| c24-enterprise-120 ‘
f ) 4 32GB 100GB uss290
| c4-highmem-32 ‘
f 4 8GB 100GB uUss$138
| c4-standard-& ‘
) 8 16GB 100GB uss2s7
| c8-highmem-16 ‘
8 32GB 100GB uss420
| c&-highmem-32 ‘
f ) 8 62GB 100GB UsSs$500
| c&-highmem-62 ‘
Additional Options
Operating System
Cent0OS 7.2
CentOS 6.7
® Ubuntu 14.04 LTS
MPLS VPN
Gold ‘ | Silver+ ‘ ‘ silver | | Bronze
Port Speed
M 900M
Length of Contract
12 - Month -
‘ Get Quote ‘
3 Change MPLS Hong Kong OCRO005.0001.V.01
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7.2.2 Create New laaS only

Piease configure your service before requesting your quote

Select 3 Server Package

Package vCPU RAM HDD Monthly Charge
1 2GB 100GB UsSs43
¢1-standarg-2
1 4GB 100GB uUsse2

c1-standard-4

1 8GB 100GB USS$96
c1-slandard-8
16 108GB 100GB usss4o
c16-enterprise-108
2 16GB 100GB UsSs$171
c2-highmem-16
2 8GB 100GB UsSs110
c2-standard-8
24 120GB 100GB USS$2400
c24-enterprise-120
4 32GB 100GB uss$290
c4-highmem-32
4 8GB 100GB uss13ge
c4-standard-8
8 16GB 100GB USS$257
¢8-highmem-16
8 32GB 100GB UsS$420
¢8-highmem-32
8 62GB 100GB usSs$s500

¢8-highmem-62

Additional Options
Operating System
CentOS 72
CentOS67

® Ubuntu 14 04 LTS

Length of Contract

12 - Month -

Get Quote

10
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7.3 Stage 3: Get Quote (for Add and Change services)

vy Iy

e After finishing the configuration, click on “Get Quote” button to get a quotation summary of the
configured item.

Configure Service

Please configure your service before requesting your quote

1 Change laaS Hong Kong Z77002.18.1S.0018 o

PCCWGlobal’

Quotation on Infrastructure-as-a-Service (laaS)

Company Name: Quotation Date:
ZZ7002 01-Mar-2017

Customer Name: Quotation Expiry Date:
Z77002 01-Apr-2017

Email:

cortex@pccwglobal com

Recurring Charges
Item Description Monthly Price | Quantity Total Price

1 laas Package: c1-standard-4 US$65 1 1US$65
Configuration: vCPU x 1, 4GB RAM, 100GB HDD

Additional Options
2 Cent0S 6.7 USS0 | - Uss0

Total Contract Price US$112
Contract Period

One (1) Month

Terms & Conditions

This quote excludes VAT, sales taxes and all other taxes and duties.

Pricing is valid until quote expiry date stated above

If discrepancies arise out of this quote or the offer, PCCW Global's decision is final

Service availability is subject to the resource availability and operational feasibility at the time of provisioning.

When the Offer is accepted it shall be subject to the PCCW Global General Terms and Conditions of Supply of Telecommunications
Services and the Product Specific Terms

| Back | Save Quote

11
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e Click on “Save Quote” button to save the configured item as a Quotation, or click on “Back” button
to return and make changes.

My Products My Services a & &

S 1)

Configure Service

Please configure your service before requesting your quote

1 New Service laaS Hong Kong o

Thank you for using our service. Please use the following reference number for your quotation request:

Quote ID: 0099551

| Close

e Once the quotation is saved successfully, a notification with a Quote ID will display.

e There is a count next to the shopping cart icon m to show the number of quotations that are
still valid and can be turned into an order
e Clicking on “Close” will collapse the quoted item and you can continue to work.

7.4 Stage 4: Shopping Cart and Submitting Orders (Turning quotations into orders)

y

12
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e By clicking on the Shopping Cart icon m (the top right hand menu item), saved quotations can
be retrieved from the system.

My Products My Services o & & #
Saved Quotes No. of items per page:

Please select Quote to proceed ordering

m
=

Quote ID Action Product Location Quote Date Price

0099550 New Service  Cloud Connect Hong Kong 01-Mar-2017  US$83

0099549 New Service  Infrastructure-as-a-Service (laaS) Hong Kong 01-Mar-2017  US$585

0099548 New Service  Infrastructure-as-a-Service (laaS) Hong Kong 01-Mar-2017  US$174

0099547 New Service  Infrasiructure-as-a-Service (laaS) Hong Kong 01-Mar-2017  US$174

0099545 New Service  Cloud Connect Hong Kong 28-Feb-2017  US$83

0099543 New Service  Cloud Connect Hong Kong 28-Feb-2017 US$83

0099541 New Service  Infrastructure-as-a-Service (laaS) Hong Kong 27 Feb-2017  US$23,475

0099538 Change Cloud Connect Hong Kong 24 Feb-2017 US$126

0099537 Change Cloud Connect Hong Kong 24-F

0099536 Change Cloud Connect Hong Kong 24 Feb-2017 US$126

First = Previous n 2 3 4 5 Next Last

e The item line will expand and display the quotation form. Customers are required to fill in additional
information for the order.

13
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e Place laaS and laaS Connect Order

My Produ

My Services

TR -4

Saved Quotes No. of items per page [6_ =

Please select Quote to proceed ordering

l 0099551 New Service 01-Mar-2017  USS$170
=
POCCW Global
Quotation on Infrastructure-as-a-Service (laasS)
Company Name: Guotation Date:
Betans Gompany
Customer Nam.
Beta User o4
Email
beta0a@pcewalobal com
Recurring Charges
Item Description | Monthly Price | Quantity | Total Price

[Configuration: vePU x RAM, 100GE HDD

laas Package: ¢1-standara-g ‘

Ussior : | Ussior

Additional Options

= [Cbunt 1404 7S I I - I
‘Mm S VPN (bronze) - 1M ‘ | 1 | FEE
Total Contract Price US$170
Contract Period

One (1) Month

Terms & Conditions
This quote excludes VAT, sales taxes and all other taxes and duties
s valid until quote expiry date stated above
screpancies arise out of this quote or the offer, PC
> availability is subject lo the r
the Offer is accepted,
Product Specific Terms

“W Global's decision is final
ource availability and operational feasibility at the time of provisioning
it shall be subject 1o the PCCW Global General Terms and Conditions of Supply of Telecommunications Services and the

Pleass fill in the following information to complete your order.

Please enter Privata IP subnet €

/
AS Number @
AS o oocxx
1P White List €&
Customer Entity
Beta Customer 004 [DCRO04] =

Activation Date
' Provision Now
/I have read, understood and accepted the Product Specific Terms & Conditions

/'l have read, understood and accepted the Online Terms

0099550 New Service Cloud Connect Hong Kong 01-Mar-2017 ussa3

099549 New Service Infrastructure-as-a-Service (laas) Hong Kong 01-Mar-2017 uUsSs585

0099548 New Service Infrastructure-as-a-Service (laaS) Hong Kong 01-Mar-2017 usSs174

0099547 New Service Infrastructure-as-a-Service (laaS) Hong Kong 01-Mar-2017 uss$174

previous [ll 2| 2| 4 5| next | Lasm

HKT oo o Gopyrant @ 2017 FCGW Giobal | Anut PECW Global |

erms and Cenditions | User Guide & POCW-HKT Group member
Te | Help & Support

14
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e Place mouse over the i to view the tooltips hint
Services and the Product Specific Terms.

Enter the private IP subnetin

Please fill in the following informatio CIDR notation (for example,
10.100.1.0/24) for your network
Please enter Private |P subnet € SEUICLE=REERL A EELE LY
your network administrator make

M sure the entered private IP subnet

is not being in-used.

AS Number @
AS

Please enter Private IP subnet @

Input a valid Autonomous System
(AS) number to create a private
A= i virual interface. You can pick any

private AS number between
AS G5 535

AS Number &

AS Determines the traffic thatcan
= reach your virtual machine.
Specify an IP address range in

: i CIDR notati for ex; I
IP White List @ notation (for example,

10.100.2.0/24) and you can input
more IP address ranges by
adding the IP address range in a
new line.

e Click on the Product Specific Terms & Conditions link to read the information
e Click on the Online Terms link to read the informatio%
tions

| have read, understood and accepted the Product S?Terms & Co

| have read, understood and accepted the Online Ter

e Check the check box to confirm you have read and understand the Terms & Conditions

e Once all required information is filled in, hit the <Confirm & Submit> button.
be created and saved.

A service order will

15
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Please note at the ordering stage, required parameters are different for different services.
8. Order Enquiries - Checking on Placed Orders

e Orders can be checked via Order Enquiry selection on the top menu "My Services"
e Click on Order Enquiry from the top menu

My Products My Services - % & A

Order Enquiry No. of items perpage: |5 -

Please select a Service:

laas -

09-Nov-2016 08:55:16(GMT)  09-Nov-2016 08:55:35(GMT) Completed

09-Nov-2016 08:49:47(GMT)  09-Nov-2016 08:52:53(GMT) In Operation

09-Nov-2016 08:41:56(GMT)  09-Nov-2016 08:44:40(GMT)  In Operation

09-Nov-2016 04:49:23(GMT)  09-Nov-2016 04:49:45(GMT) Completed

08-Nov-2016 20:29:32(GMT)  08-Nov-2016 20:32:13(GMT)  In Operation

First = Previous 1 Next = Last

e From the enquiry list, order details and the status of the order can be found
e The Order Status has 3 stages:

» Order acknowledged

» Under provisioning

» Completed / in Operation

Order Acknowledged: Service Order has been sent for resource provisioning and awaiting results
Under Provisioning: Ordered service is under provisioning

In Operation: Service has completed and is operational

Completed: A change or termination is successfully completed.

NB: Order Status will be updated in accordance with the self-provisioning process of the back-end
orchestrating platform. It may take up to a few minutes for some updates.

16
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9. Change Subscribed Services

The process flow of changing an existing service is the same as "Select > Configure > Quote > Order" -
mentioned above, thus this section only highlights the differences in "Select" and "Configure" stages.

e In "Select" stage, selection of the building (where the service is located) on the Global View is done

this way:
> Single click on the icon
> A pop up box will appear and display all ordered services under the selected location

My Products My Services B -ﬂ ‘ #

T |
=
y Cloud Connect
uuuuuuu Infrastructure-as-a-
i Kazakhstan Service
- 5: ‘|' . ;n ""’.‘ A 5 . e o laas
— x
Infrastructure-as-a-Service 128243 (HONG KONG) Operation B 9 X @0 = - e
L3 VPN - Wholesale 121976 (HONGKONG) Operation D9 X MW
Cloud Connect (MPLS VPN) 125180 (HONGKONG) Operation D9 X MO
PCCWG laaS Connection - MPLS 125480 (HONG KOMG) Operation D X Mo
‘){ Infrastructure-as-a-Service 125481 (HONG KONG) Operation E 'D 0 E
> Select the service that needs to be changed, then click on the icon X
> A number will appear on the Configuration icon to indicate the number of configurations that

have been selected. Next, click on the Configuration icon 6 to configure the product.

e In the "Configure" stage, VM Favor can be changed for laaS services, whereas Bandwidth, COS & IP White List
can be changed for laaS Connect services.

9.1 Change laaS VM Favor (Configure stage)

e The original favor will be displayed on screen, and allowed to be changed by users. The new configuration
must have higher configured items than the original one (i.e. more number of CPU, or more RAM size).

17
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U G . d Issue 4
(General Ordering | 5, 18 of 26
Prod UCt) Issue Date 01 Mar 2017
Configure Service
Please configure your service before requesting your quote
1 Change laaS Hong Kong Z77002.18.1S.0018 i)
Select a Server Package
Package vCPU RAM HDD Monthly Charge
1 2GB 100GB Uss43
f ) 1 4GB 100GB usse2
‘ c1-standard-4 ‘
i ] 1 8GB 100GB US$96
‘ c1-standard-8 ‘
) 16 108GB 100GB Us$s40
‘ c16-enterprise-108 ‘
f ) 2 16GB 100GB uss$171
‘ c2-highmem-16 ‘
i ] 2 8GB 100GB uss$110
‘ c2-standard-8 ‘
] 24 120GB 100GB USs$2400
‘ c24-enterprise-120 ‘
) 4 32GB 100GB uUs$290
‘ c4-highmem-32 ‘
f ) 4 8GB 100GB uss$138
‘ c4-standard-8 ‘
8 16GB 100GB US$257
‘ c8-highmem-16 ‘
) 8 32GB 100GB uss$420
‘ c8-highmem-32 ‘
f 8 62GB 100GB uUs$500
‘ c8-highmem-62 ‘
Additional Options
Operating System: CentOS 6.7
VM uuid:
Contract Start Date: 2017-02-23
Contract Length: 1 Months
Get Quote |
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9.2 Change laaS Connect Bandwidth, COS and IP White List (Configure stage)

Home My Products My Services A_BE- I W W

e 9

Configure Service

Please configure your service before requesting your quote

Hong Kong

Hong Kong

Hong Kong ‘OCR005.33.AC.0033

MPLS VPN

S S I =

Port Speed

1M 900M

Contract Start Date: 2016-09-06

Contract Length: 12 Months

Get Quote

e Bandwidth and COS can be changed simultaneously
e At the bottom of the screen customers may also change the IP White List which is a price-independent
modification to laaS Connect services (original IP White List is retrieved for editing)

e Getting Quote from COS/Bandwidth changes is a separate function from changing IP White List, for which the
latter action will be directly submitted without the "Quote" step.

Edit IP White List
172.100.0.0/32

List of IPs:
172.100.0 0/32
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9.3 VM Start/Stop/Reboot

From the Service Pop up Panel, a VM can be managed with the Start/Stop/Reboot button.

Service o Switch to Local View
More
Cloud Connect (MPLS VPN) 128242 (HONG KONG) Provisioning '_"3) Acfions

Infrastructure-as-a-Service 128243 (HONG KONG) Operation B 9 % »?_:

sy

e @

-

2
5‘.::J‘,J\Relr-eat B ".'D \/{ D
—

Action Buttons:
Stop / Reboot the VIV

9.3.1 Start astopped VM

When a VM is in the Stopped state, the status colour is red n and it can be started from
the Service Pop up Panel. Click on the <<Start>> button and click on <<Confirm>>, the VM
will be started.

Service o Switch to Local View

Cloud Connect (MPLSWPN) 128242 (HONG KONG) Provisioning "\3_)

nﬁIn"rastrutture-as-a—Service125243 Start BE 9 X 0
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ervice o Switch to Local View

Cloud Connect (MPLS VPN) 128242 (HONGKONG) Provisioning 'f_f)
A = Infrastructure-as-a-Service 128243 =l B 9 X @ =
&
ﬁg‘w
Al
l.II F”'r,p\\
I/\\‘:D‘r-’ﬁ,\,(\
)
~S

The status of the VM is now started and the colour is Green

Service o Switch to Local View

Cloud Connect (MPLS VPN) 128242 (HONGKONG) Provisioning ':D

SIn‘rastructure-as-a-Service 128243 | start | Stop | | Reboot | B 9 % @O =

9.3.2 Stop arunning VM

When a VM is running (status colour is Green ), it can be stopped from the Service Pop up
Panel. Click on the <<Stop>> button and click on <<Confirm>> to stop the VM.

e @) x
9

Cloud Connect (MPLS VPN) 128242 (HONG KONG) Provisioning

CIn"rastructure-as-a-Service 128243 | start | stop | [ Reboot | B 9D X O =
o Switch to Local View

Cloud Connect (MPLS VPN) 128242 (HONG KONG) Provisioning 9

8In‘rastrurture-as-a-Ser\.-'[ce 128243 Stop || Reboot | B 9 X @0 =

The status colour is now Red n and the VM is stopped.
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Service o Switch to Local View

Cloud Connect (MPLS WPN) 128242 (HONG KONG) Provisioning ':J)

ncIn"rastructure-as-a-Sewice125243 |'Start‘| B 9 X @1 =

9.3.3 Reboot a running VM

When a VM is running, it can be rebooted from the Service Pop up Panel. Click on the
<<Reboot>> button and click on <<Confirm>> to reboot the VM.

o Switch to Local View

Cloud Connect (MPLS WVPN) 128242 (HONG KONG) Provisioning ‘D

/\ Z Infrastructure-as-a-Service 128243 | Stop B 9 %X O
- /?.o““mi
p 1/ ameal

Il

N
6y
)
Service o Switch to Local View X
Cloud Connect (MPLS WPN) 128242 (HONG KONG) Provisioning ':]) .
CIn‘rastructure-as-a-Service125243 | stop || Reboot | B 9 X 0 =

9.4 VM Start/Stop/Reboot General Rules

e When the VM is not running, the status colour will be Red ., the button <<Stop>> and <<Reboot>> will be
disabled

e When the VM is in “running” state, the status colour will be Green , the <<Stop>> button will be disabled

10. Terminate Subscribed Services

The process flow of terminating an existing service is "Select > Configure > Order" without the "Quote"
step.

22




Service No. . UG-OSCAR-laaS
Orchestration
User Guide
(General Ordering | 5, . 930f 26
Flow & laaS
Prod UCt) Issue Date : 01 Mar 2017

Issue 4

PCCW Global

e In "Select" stage, select the building icon of where the service is located on the Global View
> Single click on the icon
> A pop up box will appear and display all ordered services under the selected location

My Products My Services - ¢' ‘ *

sran  Cloud Connect

 United States "
R\ MS Azure

\\/ (Hong Kong

Infrastructure-as-a-
Service

Service o x (=) aas

__Mali

Tnfrastruciure-as-a-Senvice 123510 (HONG KONG) Saved Quote ) R = (Hong kong
Cloud Connect (MPLS VPN) 123511 (HONGKONG) Saved Quote 9 @} laas
7 (Reston)
L3 VPN - Wholesale OCRO005.0001.V.01 113327 (HONGKONG) Operation '9 X (m
Cloud Connect (MPLSVPN) 123502 (HONGKONG) Provisioning '3
Cloud Connect (MPLS VPN) 123512 (HONGKONG) Provisioning '9

e Select the service to terminate. Click on the Bin icon ] .
e Terminate Service instruction will drop into Configure Page
e A number will appear on the Configuration icon to indicate the number of configurations selected.

Next, click on the configuration icon e to configure the service.

10.1 Terminate laaS Connect or laaS (Configure stage)
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Configure Service

Please configure your service before requesting your quote

1 Terminate laaS Hong Kong

Select a Server Package

Package vCPU RAM
1 2GB
1 4GB
1 8GB

16 108GB
2 16GB
2 8GB

24 120GB
4 32GB
4 8GB

8 16GB
8 32GB
8 62GB

Additional Options

Operating System: Ubuntu 14.04 LTS

VM uuid:

Contract Start Date: 2017-02-14

Contract Length: 12 Months

Termination Date

Terminate Now

02-Mar-2017 00:00 GMT

Select the item line for the next action

Tick the box "Terminate Now" (Scheduled Termination feature is not yet available)

Click on the <Submit Termination> button
The Termination request is sent out and the Order is saved.

HDD

100GB

100GB

100GB

100GB

100GB

100GB

100GB

100GB

100GB

100GB

100GB

100GB

‘OCR002.49.1S.0049

Monthly Charge

uss$43

uUss62

UsS$96

Us$840

uUs$171

uss110

Us$2400

Us$290

us$138

us$257

us$420

Us$500

Submit Termination
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Product)

Home My Products My Services

e 9

Configure Service

Please configure your service before requesting your quote

New Service

Terminate

Order 1D: 79031

HKTHL‘IL‘TD‘M\E-‘ Copyright © 2016 PCCW Global | About PCCW Global SP

| Terms and Conditions | User Guide | v1.0.0

OCRD005.32.15.0032

[ ooee |

a PCCW-HKT Group member




Adding New laaS:

Prerequisites
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11. Appendix
Note

Service Provisioning — Service Orchestration on laa$S Service

(1) Add New laaS Connect

(1) Add New laaS Connect

Request Action laaS Connect laas Action Perform
Add New laaS Non-Exist Non-Exist
(2) Add New laaS
Add New laaS Non-Exist Exist
(2) Add New laaS
Add New laa$S Exist Non-Exist (1) Add New laa$S
Add New laaS Exist Exist (1) Add New laaS
Terminate laas:
Prerequisites
Request Action 1aaS Connect laas Action Perform
Terminate laaS Connect Exist Non-Exist (1) Delete laaS Connect
Terminate laaS Exist Exist (1) Delete laaS

~-END -
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